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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

HP Compaq 8710w
Mobile Workstation

Product Name

HP Compaq 8710w Mobile
Workstation

√

HP Compaq 8710p Notebook PC
Processors

Chipset

Graphics

HP Compaq 8710p
Notebook PC

√

Intel® Core™ 2 Duo processors
T9500 2.6-GHz processor 6-MB L2
cache, 800-MHz FSB

√

√

T9300 2.5-GHz processor 6-MB L2
cache, 800-MHz FSB

√

√

T8300 2.4-GHz processor 3-MB L2
cache, 800-MHz FSB

√

√

T8100 2.1-GHz processor 3-MB L2
cache, 800-MHz FSB

√

√

T7800 2.5-GHz processor 4-MB L2
cache, 800-MHz FSB

√

√

T7700 2.4-GHz processor 4-MB L2
cache, 800-MHz FSB

√

√

T7500 2.2-GHz processor 4-MB L2
cache, 800-MHz FSB

√

√

T7300 2.0-GHz processor 4-MB L2
cache, 800-MHz FSB

√

√

T7250 2.0-GHz processor 2-MB L2
cache, 800-MHz FSB

√

√

T7100 1.8-GHz processor 2-MB L2
cache, 800-MHz FSB

√

√

Northbridge: Intel 965PM with iAMT
support

√

√

Southbridge: Intel ICH8M-enhanced

√

√

nVidia NB8E-GLM (G84GLM-UU)
graphics card with 512-MB graphics
subsystem memory operating at 800
MHz

√

nVidia NB8P-NVS2 (G84M-GT)
graphics card with 256-MB graphics

√
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Category

Description

HP Compaq 8710w
Mobile Workstation

HP Compaq 8710p
Notebook PC

subsystem memory operating at 700
MHz (supports TurboCache)

Panel

Memory
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OpenGL driver support

√

All display assemblies include 3 wireless
local area network (WLAN) antennae

√

√

17.0-inch WUXGA WVA AntiGlare

√

√

17.0-inch WSXGA+ WVA AntiGlare

√

√

17.0-inch WXGA+ AntiGlare

√

√

17.0-inch WSXGA+ Bright View

√

√

Supports privacy film

√

√

2 customer-accessible/upgradable
memory module slots

√

√

Supports dual-channel memory

√

√

Supports up to 8 GB of system RAM

√

√

PC2-5300, 667-MHz, DDR2

√

√

Supports the following configurations:

√

√

●

8192-MB total system memory
(4096 × 2, dual-channel)

●

6144-MB total system memory
(4096 + 2048)

●

5120-MB total system memory
(4096 + 1024)

●

4608-MB total system memory
(4096 + 512)

●

4096-MB total system memory
(2048 × 2, dual channel

●

4096-MB total system memory
(4096 × 1)

●

3072-MB total system memory
(2048 + 1024)

●

2560-MB total system memory
(2048 + 512)

●

2048-MB total system memory
(1024 × 2, dual-channel)

●

2048-MB total system memory
(2048 × 1)

●

1536-MB total system memory
(1024 + 512)

●

1024-MB total system memory
(512 × 2, dual-channel)
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Category

HP Compaq 8710w
Mobile Workstation

HP Compaq 8710p
Notebook PC

Supports 9.5-mm, 2.5-inch hard drives

√

√

Customer-accessible

√

√

Serial ATA

√

√

Supports the following drives:

√

√

HP 3D DriveGuard

√

√

Fixed (removal of 1 screw required)

√

√

Customer-accessible

√

√

Parallel ATA

√

√

12.7-mm tray load

√

√

Supports the following drives:

√

√

Supports external USB diskette drive
only

√

√

Supports boot from external USB
diskette drive

√

√

Supports 3-mode diskette drive

√

√

Microphone

Integrated microphone

√

√

Audio

HD audio - ADI1981

√

√

Modem

56K V.92 1.5-inch data/fax modem with
digital line guard

√

√

Hard drives

Optical drives

Diskette drive

Description
●

1024-MB total system memory
(1024 × 1)

●

512-MB total system memory (512
× 1)

●

250-GB, 5400-rpm

●

200-GB, 7200--rpm

●

160-GB, 7200- and 5400-rpm

●

120-GB, 7200- and 5400-rpm

●

100-GB, 7200-rpm

●

80-GB, 7200- and 5400-rpm

●

DVD±RW and CD-RW Super Multi
Double-Layer Combo Drive with
LightScribe

●

DVD±RW and CD-RW Super Multi
Double-Layer Combo Drive

●

DVD-CD/RW Combo Drive

●

Blu-Ray DVD-RW Combo Drive

●

DVD-ROM Drive
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Category

Ethernet

Wireless

Description

HP Compaq 8710w
Mobile Workstation

HP Compaq 8710p
Notebook PC

HD audio interface

√

√

Modem cable included in Brazil, the
Czech Republic, Europe, France,
Greece, Hungary, Israel, Latin America,
Poland, Russia, Saudi Arabia, Slovakia,
Slovenia, South Africa, Turkey, and the
United Kingdom

√

√

Intel 82566MM 10/100/1000 network
interface card (NIC) with iAMT

√

√

S3/S4/S5 wake on LAN: DC - no

√

√

S3/S4/S5 wake on LAN: AC - yes

√

√

NIC power-down technology

√

√

Integrated WLAN options by way of wireless module:
Three WLAN antennae built into display
assembly

√

√

Support for no-WLAN option

√

√

Support for the following WLAN formats: √

√

●

Intel 802.11a/b/g/n with iAMT
support

●

Broadcom 802.11a/b/g

●

Intel 802.11a/b/g with iAMT
support

●

Broadcom 802.11b/g

Integrated personal area network (PAN) options by way of Bluetooth® module:

External media card

Ports
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Support for no-WPAN option

√

√

Broadcom Bluetooth

√

√

One Type I/II PC Card slot, supporting
16-bit and 32-bit (Cardbus) PC Card
modules

√

√

Media Card Reader slot supporting SD,
MMC, MS, MSP, xD, and Memory Stick
Duo

√

√

Audio-in (mono microphone)

√

√

Audio-out (stereo headphone)

√

√

High-Definition Multimedia Interface
(HDMI)

√

√

RJ-11 (modem)

√

√

RJ-45 (Ethernet, includes link and
activity lights)

√

√

USB (6)

√

√
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Category

Description

HP Compaq 8710w
Mobile Workstation

HP Compaq 8710p
Notebook PC

VGA (Dsub 15-pin) supporting 1600 ×
√
1200 external resolution at 75-GHz (hot
plug/unplug with auto-detect)

√

3-pin AC power

√

√

Docking

HP 3-in-1 NAS Docking Station, HP
Advanced Docking Station, and HP
Docking Station

√

√

Keyboard/pointing
devices

14.4-inch keyboard with separate
numeric keypad

√

√

Dual point (pointing stick and
TouchPad) with 3 pointing stick buttons
and 3 TouchPad buttons and vertical
scrolling (taps enabled as default)

√

√

Power requirements

Security

Operating system

TouchPad only, with 2 TouchPad
buttons and vertical scrolling (taps
enabled as default)

√

Windows Vista™ Hardware Start Button √

√

The following AC adapters with localized
cable plug support (3-wire plug with
ground pin, supports 3-pin DC
connector):

√

√

8-cell, 2.55-Ah (73-Wh) Li-ion battery

√

√

Support for 8-cell Extended Life Battery

√

√

Support for 12-cell Ultra Capacity
Battery

√

√

Full volume encryption

√

√

Integrated fingerprint reader

√

√

Integrated smart card reader

√

√

Preboot authentication (password,
smart card)

√

√

Security cable slot

√

√

Trusted platform module (TPM) V.1.2

√

√

Windows Vista Business 32/64

√

√

Windows Vista Home Basic 32

√

√

●

180-W PFC AC adapter

●

135-W PFC AC adapter

●

120-W non-PFC and PFC AC
adapters

●

90-W non-PFC and PFC AC
adapters

Preinstalled:
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Category

Description

HP Compaq 8710w
Mobile Workstation

HP Compaq 8710p
Notebook PC

Windows® XP Professional

√

√

FreeDOS

√

√

√

√

Preinstalled with Microsoft® Office:
Windows Vista Business 32/64 with
Office 2007 Ready
Windows Vista Business 32/64 with
Office 2007 Personal

√

Windows XP Professional with Office
2007 Ready

√

√

Windows XP Professional with Office
2007 Personal

√

√

Windows Vista Business 32/64

√

√

Windows Vista Home Basic 32

√

√

Windows XP Professional

√

√

DRDVD XP

√

√

DRDVD Vista

√

√

√

√

√

√

AC adapter

√

√

Battery (system)

√

√

Battery (RTC)

√

√

Hard drive

√

√

Memory module

√

√

Modem module

√

√

Optical drive

√

√

WLAN module

√

√

Restore media:

Supported:
Windows® 2000
Certified:
Linux
Serviceability
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End-user replaceable parts:
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2

External component identification

Display components

Item

Component

Function

(1)

Ambient light sensor

When activated, the sensor automatically adjusts the
display brightness based on the surrounding lighting
conditions.

(2)

Wireless antenna locations

Send and receive wireless signals to communicate with
WLANs.

(3)

Internal microphone

Records sound.

Display components
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Top components
Buttons, switches, and fingerprint reader

Item

Component

Function

(1)

Power button

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button to shut
down the computer.

●

When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about power settings, follow these steps:
●

In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

●

In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2)

Info button

Launches Info Center, which enables you to open various
software solutions.

(3)

Wireless button

Turns the wireless feature on or off, but does not establish
a wireless connection.
NOTE: A wireless network must be set up in order to
establish a wireless connection.
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(4)

Presentation button

Starts the presentation feature.

(5)

Volume mute button

Mutes and restores speaker sound.

Chapter 2 External component identification

Item

Component

Function

(6)

Volume scroll zone

Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You
can also press the left side of the volume slider to decrease
volume, or press the right side of the volume slider to
increase volume.

(7)

Calculator button

Turns on the Windows calculator function.

(8)

HP Fingerprint Sensor (fingerprint reader)

Allows a fingerprint logon to Windows, instead of a
password logon.

Keys
NOTE:

Your computer may look slightly different from the illustration in this section.

Item

Component

Function

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

fn key

Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(5)

Integrated numeric keypad

Can be used like the keys on an external numeric keypad.

(6)

Function keys

Execute frequently used system functions when pressed
in combination with the fn key.

Top components
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Lights

Item

Component

Function

(1)

Wireless lights (2)*

●

On: An integrated wireless device, such as a WLAN
device and/or a Bluetooth® device, is on.

●

Off: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

●

Blinking rapidly: An AC adapter with a higher power
rating should be connected.

●

Off: The computer is off or in Hibernation.

●

Amber: A battery is charging.

●

Green: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

●

Blinking green: The hard drive or optical drive is being
accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

(2)

(3)

(4)

10

Power lights (2)†

Battery light

Drive light

(5)

Caps lock light

On: Caps lock is on.

(6)

Num lock light

On: Num lock is on or the integrated numeric keypad is
enabled.

Chapter 2 External component identification

Item

Component

Function

(7)

Volume mute light

●

Amber: Computer sound is turned off.

●

On: Computer sound is turned on.

(8)

Volume down light

On: The volume scroll zone is being used to decrease
speaker volume.

(9)

Volume up light

On: The volume scroll zone is being used to increase
speaker volume.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.
†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

Top components
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Pointing devices

Item

Component

Function

(1)

Pointing stick*

Moves the pointer and selects or activates items on the
screen.

(2)

Left pointing stick button*

Functions like the left button on an external mouse.

(3)

TouchPad*

Moves the pointer and selects or activates items on the
screen.

(4)

Left TouchPad button*

Functions like the left button on an external mouse.

(5)

Center TouchPad button*

Functions like the center button on an external mouse.

(6)

Right TouchPad button*

Functions like the right button on an external mouse.

(7)

TouchPad scroll zone

Scrolls up or down.

(8)

Right pointing stick button*

Functions like the right button on an external mouse.

(9)

Center pointing stick button*

Functions like the center button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:
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●

In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

●

In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.

Chapter 2 External component identification

Front components

Item

Component

Function

(1)

Wireless light

●

On: An integrated wireless device, such as a WLAN
device and/or a Bluetooth device, is on.

●

Off: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

●

Blinking rapidly: An AC adapter with a higher power
rating should be connected.

●

Off: The computer is off or in Hibernation.

●

Amber: A battery is charging.

●

Green: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

●

Blinking green: The hard drive or optical drive is being
accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(2)

(3)

(4)

Power light

Battery light

Drive light

(5)

Speakers (2)

Produce sound.

(6)

Display release latch

Opens the computer.

(7)

Media Card Reader

Supports the following optional digital card formats: Secure
Digital (SD) Memory Card, Memory Stick Pro, Memory
Stick Duo, xD-Picture Card, and MultiMediaCard (MMC).

Front components
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Left-side components

Item

Component

Function

(1)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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(3)

Power connector

Connects an AC adapter.

(4)

HDMI port

Connects an optional HDMI device.

(5)

External monitor port

Connects an external VGA monitor or projector.

(6)

USB ports (2)

Connect optional USB devices.

(7)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(8)

Smart card reader

Supports smart cards and Java™ cards.

(9)

PC Card slot

Supports optional Type I or Type II 32–bit (CardBus) or 16–
bit PC Cards.

(10)

PC Card eject button

Ejects a PC Card from the PC Card slot.

Chapter 2 External component identification

Rear component

Component

Function

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

Right-side components

Item

Component

Function

(1)

Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

(2)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3)

USB ports (4)

Connects up to 4 optional USB devices.

(4)

Optical drive

Reads an optical disc.

(5)

Optical drive button

Releases the media tray.

(6)

RJ-11 (modem) jack

Connects a modem cable.

(7)

RJ-45 (network) jack

Connects a network cable.

Rear component
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Bottom components

Item

Component

Function

(1)

Battery bay

Holds the battery.

(2)

Battery release latches (2)

Release the battery from the battery bay.

(3)

Docking connector

Connects an optional docking device.

(4)

Accessory battery connector (slide open to expose)

Connects an optional accessory battery.

(5)

Hard drive bay

Contains the hard drive and the Bluetooth module.

(6)

Vents (3)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(7)

Memory module/WLAN module compartment

Contains the expansion memory module slot, the WLAN
module slot, and the RTC battery.
CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.
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Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.

Serial number location
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Computer major components

Item

Description

(1)

Display assemblies (include 3 WLAN antenna transceivers and cables)
17.0-inch, WUXGA WVA AntiGlare
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Spare part number

450582-001

Item

Description

Spare part number

17.0-inch, WSXGA+ WVA AntiGlare

450580-001

17.0-inch, WSXGA+ WVA BrightView

450581-001

17.0-inch, WXGA+ AnitGlare

450583-001

Display internal components (not illustrated):
Ambient light sensor board

450480-001

Display bezel

450500-001

Display inverter

450498-001

Display Bracket Kit (includes left and right display hinges)

450570-001

Display panel cable

450571-001

Wireless Antenna Kit (includes 3 WLAN antenna transceivers and cables)

450475-001

Display enclosure for use with WUXGA display assemblies (includes 3 WLAN antenna
transceivers and cables)

456223-001

Display enclosure for use with WSXGA+ and WXGA+ display assemblies (includes 3 WLAN
antenna transceivers and cables)

450572-001

Display Rubber Kit (includes display bezel rubber screw covers)

450573-001

Display Screw Kit

450574-001

(2)

Switch cover (includes LED board and cable)

450479-001

(3)

Power button board (includes cable)

450481-001

(4)

Keyboards with pointing stick (include pointing stick cable)
For use in Belgium

450471-A41

For use in Brazil

450471-201

For use in the Czech Republic

450471-221

For use in Denmark

450471-081

For use in France

450471-051

For use in French Canada

450471-121

For use in Germany

450471-041

For use in Greece

450471-151

For use in Hungary

450471-211

For use in Iceland

450471-DD1

For use in Israel

450471-BB1

For use in Italy

450471-061

For use in Japan

450471-291

For use in Latin America

450471-161

For use in the Netherlands and Europe

450471-021

For use in Norway

450471-091

Computer major components
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Item

Description

Spare part number

For use in Portugal

450471-131

For use in Russia

450471-251

For use in Saudi Arabia

450471-171

For use in Slovakia

450471-231

For use in Slovenia

450471-BA1

For use in South Korea

450471-AD1

For use in Spain

450471-071

For use in Sweden and Finland

450471-B71

For use in Switzerland

450471-111

For use in Taiwan

450471-AB1

For use in Thailand

450471-281

For use in Turkey

450471-141

For use in the United Kingdom

450471-031

For use in the United States

450471-001

Keyboards without pointing stick
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For use in Belgium

450472-A41

For use in Brazil

450472-201

For use in the Czech Republic

450472-221

For use in Denmark

450472-081

For use in France

450472-051

For use in French Canada

450472-121

For use in Germany

450472-041

For use in Greece

450472-151

For use in Hungary

450472-211

For use in Iceland

450472-DD1

For use in Israel

450472-BB1

For use in Italy

450472-061

For use in Japan

450472-291

For use in Latin America

450472-161

For use in the Netherlands and Europe

450472-021

For use in Norway

450472-091

For use in Portugal

450472-131

For use in Russia

450472-251

For use in Saudi Arabia

450472-171

Chapter 3 Illustrated parts catalog

Item

(5)

(6)

Description

Spare part number

For use in Slovakia

450472-231

For use in Slovenia

450472-BA1

For use in South Korea

450472-AD1

For use in Spain

450472-071

For use in Sweden and Finland

450472-B71

For use in Switzerland

450472-111

For use in Taiwan

450472-AB1

For use in Thailand

450472-281

For use in Turkey

450472-141

For use in the United Kingdom

450472-031

For use in the United States

450472-001

TouchPads (include TouchPad cable)
For use with keyboards with a pointing stick, includes 3 pointing stick buttons and 3 TouchPad
buttons

450597-001

For use with keyboards without a pointing stick, includes 2 TouchPad buttons

450596-001

Top covers (include fingerprint reader board and cable )
For use with HP Compaq 8710w computer models

451379-001

For use with HP Compaq 8710p computer models

450595-001

(7)

Graphics card fan/heat sink (includes replacement thermal material)

450594-001

(8)

Heat sink assemblies (include replacement thermal material)
For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468593-001

For use only with computer models equipped with processors with 2- or 4-MB L2 cache

450593-001

Plastics Kit (see Plastics Kit on page 26 for more Plastics Kit spare part information):

450585-001

(9a)

PC Card slot bezel

(9b)

Memory module/WLAN module compartment cover (includes 3 captive screws, secured by C-clips)
Computer feet (not illustrated; 9 feet in 4 different sizes)

(9c)

Hard drive cover (includes 2 captive screws, secured by C-clips)

(10)

PC Card assembly

(11)

Intel Core 2 Duo processors (include replacement thermal material)

450584-001

T9500 2.6-GHz processor (6-MB L2 cache, 800-MHz FSB)

463051-001

T9300 2.5-GHz processor (6-MB L2 cache, 800-MHz FSB)

463050-001

T8300 2.4-GHz processor (3-MB L2 cache, 800-MHz FSB)

463049-001

T8100 2.1-GHz processor (3-MB L2 cache, 800-MHz FSB)

463048-001

T7800 2.6-GHz processor (4-MB L2 cache, 800-MHz FSB)

458218-001

T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB)

450589-001

Computer major components
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Item

(12)

Description

Spare part number

T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB)

450588-001

T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB)

450587-001

T7250 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB)

460283-001

T7100 1.8-GHz processor (2-MB L2 cache, 800-MHz FSB)

450586-001

Graphics cards (include replacement thermal material)
For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468592-001

For use only with HP Compaq 8710w computer models (nVidia NB8E-GLM graphics card with
512-MB graphics subsystem memory operating at 800 MHz)

451377-001

For use only with HP Compaq 8710p computer models (nVidia NB8P-NVS2 graphics card
with 256-MB graphics subsystem memory operating at 700 MHz; supports TurboCache)

450484-001

(13)

USB/audio board (includes 2-into-1 USB board cable and audio board cable)

450483-001

(14)

Bluetooth module (includes Bluetooth module cable)

450485-001

(15)

System boards (include replacement thermal material)
For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468591-001

For use only with computer models equipped with processors with 2- or 4-MB L2 cache

450482-001

(16)

Modem module

443899-001

(17)

Speaker assembly

450592-001

(18)

Base enclosure (includes rubber feet)

450476-001

Rubber Kit (includes 9 feet in 4 different sizes)

450590-001

(19)

RTC battery

450478-001

(20)

8-cell, 5.1-Ah, Li-ion battery

450477-001

(21)

Memory modules

(22)

4096-MB memory module (PC2-5300, 667-MHz, DDR2)

469650-001

2048-MB memory module (PC2-5300, 667-MHz, DDR2)

450576-001

1024-MB memory module (PC2-5300, 667-MHz, DDR2)

450575-001

512-MB memory module (PC2-5300, 667-MHz, DDR2)

450577-001

WLAN modules
Intel 802.11a/b/g/n WLAN modules:
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●

For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002
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Item

Description

Spare part number

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

●

For use in Japan

441086-291

●

For use in South Korea

441086-AD1

Broadcom 802.11a/b/g WLAN modules:
●

For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441075-001

●

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

●

For use in Japan

441075-291

Intel 802.11a/b/g WLAN modules:
●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the
United States, Uruguay, Venezuela, and Vietnam

441082-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441082-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441082-003

●

For use in Japan

441082-291 and
441082-292

Broadcom 802.11b/g WLAN modules:

Computer major components
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Item

Description

Spare part number

●

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441090-001

●

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia &
Herzegovina Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the
People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe,
Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-002

●

For use in Japan

441090-291

Intel 802.11b/g WLAN module for use in Japan
(23)

(24)
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448675-004

Hard drives (include hard drive bracket)
250-GB, 5400-rpm

458219-001

200-GB, 7200-rpm

461876-001

160-GB, 7200-rpm

460282-001

160-GB, 5400-rpm

450495-001

120-GB, 7200-rpm

454487-001

120-GB, 5400-rpm

450494-001

100-GB, 7200-rpm

450493-001

80-GB, 7200-rpm

450497-001

80-GB, 5400-rpm

450496-001

Optical drives
DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

450490-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

450491-001

DVD/CD-RW Combo Drive

450492-001

Blu-ray DVD-RW Drive

450489-001

Chapter 3 Illustrated parts catalog

Item

Description

Spare part number

DVD-ROM Drive

450488-001

Cable Kit (not illustrated; see Cable Kit on page 27 for more Cable Kit spare part number
information)

450486-001

Computer major components
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Plastics Kit

Item

26

Description

Spare part number

Plastics Kit:

450585-001

(1)

Memory module/WLAN module compartment cover (includes 3 captive screws, secured by C-clips)

(2)

Hard drive cover (includes 2 captive screws, secured by C-clips)

(3)

PC Card slot bezel

Chapter 3 Illustrated parts catalog

Cable Kit

Item

Description

Spare part number

Cable Kit:

450486-001

(1)

RJ-45 jack cable

(2)

RJ-11 jack cable

(3)

TouchPad cable

(4)

Bluetooth module cable

(5)

USB/audio board cable

(6)

Microphone extension cable

(7)

Power button board cable

Cable Kit
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Mass storage devices

Item

Description

(1)

Hard drives (include frame)

(2)

Spare part number

250-GB, 5400-rpm

458219-001

200-GB, 7200-rpm

461876-001

160-GB, 7200-rpm

460282-001

160-GB, 5400-rpm

450495-001

120-GB, 7200-rpm

454987-001

120-GB, 5400-rpm

450494-001

100-GB, 7200-rpm

450493-001

80-GB, 7200-rpm

450497-001

80-GB, 5400-rpm

450496-001

Optical drives (include bezel)
DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

450490-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

450491-001

DVD/CD-RW Combo Drive

450492-001

Blu-ray DVD-RW Drive

450489-001

DVD-ROM Drive

450488-001

Miscellaneous parts
Description

Spare part number

AC adapters

28

180-W PFC AC adapter

463952-001

135-W PFC AC adapter

468590-001
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Description

Spare part number

120-W non-PFC AC adapter

416391-001

120-W PFC AC adapter

391174-001

90-W non-PFC AC adapter

418873-001

90-W PFC AC adapter

418875-001

External MultiBay II

366143-001

External MultiBay II power cable and stand

366144-001

HP Extended Life Battery

367456-001

Label Kit

450499-001

MultiBay 8X DVD-ROM Drive

373314-001

MultiBay 24X DVD/CD-RW Combo Drive

373315-001

Nylon carrying case

325814-001

USB 1.1 diskette drive

359118-001

Power cords:
For use in Australia

403811-011

For use in Brazil

403811-201

For use in Denmark

403811-081

For use in Europe, the Middle East, and Africa

403811-021

For use in India

403811-D61

For use in Israel

403811-BB1

For use in Italy

403811-061

For use in Japan

403811-291

For use in the People's Republic of China

403811-AA1

For use in South Korea

403811-AD1

For use in Switzerland

403811-111

For use in Taiwan

403811-AB1

For use in the United Kingdom

403811-031

For use the United States

403811-001

Screw Kit

450591-001

●

Phillips PM2.5×4.0 screw

●

Phillips PM2.0×10.0 screw

●

Phillips PM2.0×5.0 captive screw

●

Phillips PM2.0×5.0 screw

●

Phillips PM2.0×4.0 screw

●

Phillips PM2.0×3.0 screw

Miscellaneous parts
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Description

Spare part number

●

Phillips PM2.0×2.0 broad-head screw

●

Phillips PM2.0×2.0 screw

●

Phillips PM1.5×3.0 screw

●

Torx T8M2.5×7.0 screw

●

Torx T8M2.5×4.0 screw

●

Torx T6M2.0×5.0 screw

Sequential part number listing
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Spare part
number

Description

391174-001

120-W PFC AC adapter

325814-001

Nylon carrying case

359118-001

USB 1.1 diskette drive

366143-001

External MultiBay II

366144-001

External MultiBay II power cable and stand

367456-001

HP Extended Life Battery

373314-001

MultiBay 8X DVD-ROM Drive

373315-001

MultiBay 24X DVD/CD-RW Combo Drive

403811-001

Power cord (3-wire) for use in North America

403811-011

Power cord (3-wire) for use in Australia

403811-021

Power cord (3-wire) for use in Europe, the Middle East, and Africa

403811-031

Power cord (3-wire) for use in the United Kingdom

403811-061

Power cord (3-wire) for use in Italy

403811-081

Power cord (3-wire) for use in Denmark

403811-111

Power cord (3-wire) for use in Switzerland

403811-291

Power cord (3-wire) for use in Japan

403811-AA1

Power cord (3-wire) for use in the People's Republic of China

403811-AB1

Power cord (3-wire) for use in Taiwan

403811-AD1

Power cord (3-wire) for use in South Korea

403811-BB1

Power cord (3-wire) for use in Israel

403811-D61

Power cord (3-wire) for use in India

416931-001

120-W non-PFC AC adapter

418873-001

90-W non-PFC AC adapter
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Spare part
number

Description

418875-001

90-W PFC AC adapter

441075-001

Broadcom 802.11a/b/g WLAN module for use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin
Islands, and the United States

441075-002

Broadcom 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome &
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St.
Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

441075-291

Broadcom 802.11a/b/g WLAN module for use in Japan

441082-001

Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441082-002

Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441082-003

Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

441082-291

Intel 802.11a/b/g WLAN module for use in Japan

441082-292

Intel 802.11a/b/g WLAN module for use in Japan

441086-001

Intel 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

441086-002

Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441086-003

Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea
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Spare part
number

Description

441086-291

Intel 802.11a/b/g/n WLAN module for use in Japan

441086-AD1

Intel 802.11a/b/g/n WLAN module for use in South Korea

441090-001

Broadcom 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441090-002

Broadcom 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-291

Broadcom 802.11b/g WLAN module for use in Japan

443899-001

Modem module

448675-004

Intel 802.11b/g WLAN module for use in Japan

450471-001

Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cable)

450471-021

Keyboard with pointing stick for use in Europe (includes keyboard and pointing stick cable)

450471-031

Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cable)

450471-041

Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cable)

450471-051

Keyboard with pointing stick for use in France (includes keyboard and pointing stick cable)

450471-061

Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cable)

450471-071

Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cable)

450471-081

Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cable)

450471-091

Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cable)

450471-111

Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cable)

450471-121

Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cable)

450471-131

Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cable)

450471-141

Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cable)

450471-151

Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cable)

450471-161

Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cable)
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Spare part
number

Description

450471-171

Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cable)

450471-201

Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cable)

450471-211

Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cable)

450471-221

Keyboard with pointing stick for use in the Czech Republic (includes keyboard and pointing stick cable)

450471-231

Keyboard with pointing stick for use in Slovakia (includes keyboard and pointing stick cable)

450471-251

Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cable)

450471-281

Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cable)

450471-291

Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cable)

450471-A41

Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cable)

450471-AB1

Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cable)

450471-AD1

Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cable)

450471-B71

Keyboard with pointing stick for use in Sweden and Finland (includes keyboard and pointing stick cable)

450471-BA1

Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cable)

450471-BB1

Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cable)

450471-DD1

Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cable)

450472-001

Keyboard without pointing stick for use in the United States (includes keyboard cable)

450472-021

Keyboard without pointing stick for use in Europe (includes keyboard cable)

450472-031

Keyboard without pointing stick for use in the United Kingdom (includes keyboard cable)

450472-041

Keyboard without pointing stick for use in Germany (includes keyboard cable)

450472-051

Keyboard without pointing stick for use in France (includes keyboard cable)

450472-061

Keyboard without pointing stick for use in Italy (includes keyboard cable)

450472-071

Keyboard without pointing stick for use in Spain (includes keyboard cable)

450472-081

Keyboard without pointing stick for use in Denmark (includes keyboard cable)

450472-091

Keyboard without pointing stick for use in Norway (includes keyboard cable)

450472-111

Keyboard without pointing stick for use in Switzerland (includes keyboard cable)

450472-121

Keyboard without pointing stick for use in French Canada (includes keyboard cable)

450472-131

Keyboard without pointing stick for use in Portugal (includes keyboard cable)

450472-141

Keyboard without pointing stick for use in Turkey (includes keyboard cable)

450472-151

Keyboard without pointing stick for use in Greece (includes keyboard cable)

450472-161

Keyboard without pointing stick for use in Latin America (includes keyboard cable)

450472-171

Keyboard without pointing stick for use in Saudi Arabia (includes keyboard cable)

450472-201

Keyboard without pointing stick for use in Brazil (includes keyboard cable)

450472-211

Keyboard without pointing stick for use in Hungary (includes keyboard cable)

450472-221

Keyboard without pointing stick for use in the Czech Republic (includes keyboard cable)
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Spare part
number

Description

450472-231

Keyboard without pointing stick for use in Slovakia (includes keyboard cable)

450472-251

Keyboard without pointing stick for use in Russia (includes keyboard cable)

450472-281

Keyboard without pointing stick for use in Thailand (includes keyboard cable)

450472-291

Keyboard without pointing stick for use in Japan (includes keyboard cable)

450472-A41

Keyboard without pointing stick for use in Belgium (includes keyboard cable)

450472-AB1

Keyboard without pointing stick for use in Taiwan (includes keyboard cable)

450472-AD1

Keyboard without pointing stick for use in South Korea (includes keyboard cable)

450472-B71

Keyboard without pointing stick for use in Sweden (includes keyboard cable)

450472-BA1

Keyboard without pointing stick for use in Slovenia (includes keyboard cable)

450472-BB1

Keyboard without pointing stick for use in Israel (includes keyboard cable)

450472-DD1

Keyboard without pointing stick for use in Iceland (includes keyboard cable)

450475-001

Wireless Antenna Kit (includes 3 WLAN antenna transceivers and cables)

450476-001

Base enclosure (includes rubber computer feet)

450477-001

8-cell, 5.1-Ah battery

450478-001

RTC battery

450479-001

Switch cover (includes LED board and cable)

450480-001

Ambient light sensor board

450481-001

Power button board (includes cable)

450482-001

System board for use only with computer models equipped with processors with 2- or 4-MB L2 cache (includes
replacement thermal material)

450483-001

USB/audio board (includes 2-into-1 USB board cable and audio board cable)

450484-001

Graphics card for use only with HP Compaq 8710p computer models (nVidia NB8P-NVS2 with 256 MB of
graphics subsystem memory operating at 700 MHz, supporting TurboCache; includes replacement thermal
material)

450485-001

Bluetooth module (includes Bluetooth module cable)

450486-001

Cable Kit (see Cable Kit on page 27 for more Cable Kit spare part information

450488-001

DVD-ROM Drive

450489-001

Blu-ray DVD-RW Drive

450490-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

450491-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

450492-001

DVD/CD-RW Combo Drive

450493-001

100-GB, 7200-rpm hard drive

450494-001

120-GB, 5400-rpm hard drive

450495-001

160-GB, 5400-rpm hard drive

450496-001

80-GB, 5400-rpm hard drive
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number

Description

450497-001

80-GB, 7200-rpm hard drive

450498-001

Display inverter

450499-001

Label Kit

450500-001

Display bezel

450570-001

Display Bracket Kit (includes left and right display hinges)

450571-001

Display cable

450572-001

Display enclosure for use with WSXGA+ and WXGA+ display assemblies (includes 3 WLAN antenna
transceivers and cables)

450573-001

Display Rubber Kit (includes display bezel rubber screw covers)

450574-001

Display Screw Kit

450575-001

1024-MB memory module (PC-5300, 667-GHz, DDR2)

450576-001

2048-MB memory module (PC-5300, 667-GHz, DDR2)

450577-001

512-MB memory module (PC-5300, 667-GHz, DDR2)

450578-001

Microphone extension cable

450580-001

17.0-inch, WSXGA+ WVA AntiGlare display assembly (includes 3 WLAN antenna transceivers and cables)

450581-001

17.0-inch, WSXGA+ WVA BrightView display assembly (includes 3 WLAN antenna transceivers and cables)

450582-001

17.0-inch, WUXGA+ WVA AntiGlare display assembly (includes 3 WLAN antenna transceivers and cables)

450583-001

17.0-inch, WXGA+ AntiGlare display assembly (includes 3 WLAN antenna transceivers and cables)

450584-001

PC Card assembly

450585-001

Plastics Kit (see Plastics Kit on page 26 for more Plastics Kit spare part information)

450586-001

Intel Core 2 Duo T7100 1.8-GHz processor (2-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

450587-001

Intel Core 2 Duo T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

450588-001

Intel Core 2 Duo T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

450589-001

Intel Core 2 Duo T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

450590-001

Rubber Kit (includes base enclosure rubber feet

450591-001

Screw Kit

450592-001

Speaker assembly

450593-001

Heat sink for use only with computer models equipped with processors with 2- or 4-MB L2 cache (includes
replacement thermal material)

450594-001

Fan/heat sink assembly (includes replacement thermal material)

450595-001

Top cover for use with 8710p computer models (includes fingerprint reader board and cable)

450596-001

TouchPad with 2 TouchPad buttons (for use with keyboards without a pointing stick; includes TouchPad
cable)
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450597-001

TouchPad with 3 pointing stick buttons and 3 TouchPad buttons (for use with keyboards with a pointing stick;
includes TouchPad cable)

451377-001

Graphics card for use only with HP Compaq 8710w computer models (nVidia NB8E-GLM with 512 MB graphics
subsystem memory operating at 800 MHz; includes replacement thermal material)

451379-001

Top cover for use with 8710w computer models (includes fingerprint reader board and cable)

416931-001

120-W non-PFC AC adapter

391174-001

120-W PFC AC adapter

454987-001

120-GB, 7200-rpm hard drive

456223-001

Display enclosure for use with WUXGA display assemblies (includes 3 WLAN antenna transceivers and
cables)

458218-001

Intel Core 2 Duo T7800 2.6-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

458219-001

250-GB, 5400-rpm hard drive

460282-001

160-GB, 7200-rpm hard drive

460283-001

Intel Core 2 Duo T7250 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

461876-001

200-GB, 7200-rpm hard drive

463048-001

Intel Core 2 Duo T8100 2.1-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

463049-001

Intel Core 2 Duo T8300 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

463050-001

Intel Core 2 Duo T9300 2.8-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

463051-001

Intel Core 2 Duo T9500 2.6-GHz processor (4-MB L2 cache, 800-MHz FSB; includes replacement thermal
material)

463952-001

180-W PFC AC adapter

468590-001

135-W PFC AC adapter

468591-001

System board for use only with computer models equipped with processors with 3- or 6-MB L2 cache (includes
replacement thermal material)

468592-001

Graphics card for use only with computer models equipped with processors with 3- or 6-MB L2 cache

468593-001

Heat sink for use only with computer models equipped with processors with 3- or 6-MB L2 cache (includes
replacement thermal material)

469650-001

4096-MB memory module (PC-5300, 667-GHz, DDR2)
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Preliminary replacement requirements
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Cables and and pointing stick connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits provide
some protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and and pointing stick can work perfectly
throughout a normal cycle. Or the device may function normally for a while, then degrade in the internal
layers, reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you area ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and and pointing stick circuitry. Handle electronic components as little as
possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION:

A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity

Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick
containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and and pointing stick conveyors made of antistatic belts and roller bushings. Be
sure that mechanized equipment used for moving materials is wired to ground and that proper
materials are selected to avoid static charging. When grounding is not possible, use an ionizer to
dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid and pointing stick contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground and pointing stick cords. To provide
proper ground, wear a strap snugly against the skin at all times. On grounded mats with bananaplug connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground and pointing stick cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V

Preliminary replacement requirements
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Unknown user password
NOTE: This process will not work if Stringent Security is enabled in F10 Setup. Stringent Security
installs passwords into the ROM so that it is not affected when the RTC battery is removed.
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:
NOTE:

These steps also clear CMOS.

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the real-time clock (RTC) battery (see RTC battery on page 57).

6.

Wait approximately 5 minutes.

7.

Replace the RTC battery and reassemble the computer.

8.

Connect AC power to the computer. Do not reinsert any batteries at this time.

9.

Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 97 screws and screw locks, in 18 different sizes, that must be removed, replaced,
or loosened when servicing the computer. Make special note of each screw and screw lock size and
location during removal and replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.

Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 450590-001. There are 9 rubber feet, in 4 different sizes, that attach to the base enclosure
in the locations illustrated below.

Component replacement procedures
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Battery
Description

Spare part number

8-cell, 5.1-Ah, Li-ion battery

450477-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside down on a flat surface, with the battery bay toward you.

2.

Slide the battery release latches (1) to release the battery.

3.

Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Display inverter and ambient light sensor board
NOTE: If it has been determined that the display inverter or the ambient light sensor board are the
components that must be replaced to complete the computer repair, the display assembly does not have
to be removed. Follow the procedures in this section to replace the display inverter or ambient light
sensor board . For information on replacing the display assembly, the display hinges, or the display
bezel, see Display assembly on page 77.
Description

Spare part number

Display inverter

450498-001

Ambient light sensor board

450480-001

Before removing the display inverter, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

Remove the display inverter:
1.

Turn the computer right-side up, with the front toward you.

2.

Open the computer as far as possible.
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3.

Remove the screw covers, screws, and stabilizer clips listed below. All rubber screw covers are
included in the Display Rubber Kit, spare part number 450573-001.
(1) Two flat rubber screw covers
(2) Two small oblong rubber screw covers
(3) Four Phillips PM2.0×6.0 screws
(4) Two stabilizer clips
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4.

Flex the inside edges of the left and right sides (1) and the display bezel bottom edge (2) until the
bezel disengages from the display assembly.

5.

Release the display bezel bottom edge (3) from the display assembly.

6.

Remove the Torx T8M2.5×4.0 screw (1) that secures the ambient light sensor board to the display
enclosure.

7.

Release the ambient light sensor board (2) from the display enclosure as far as the ambient light
sensor board cable allows.
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8.

Disconnect the ambient light sensor board cable (3) from the ambient light sensor board.

9.

Remove the Torx T8M2.5×4.0 screw (1) that secures the display inverter to the display enclosure.

10. Release the inverter (2) from the display enclosure as far as the display panel cable and backlight
cable allow.
11. Disconnect the display panel cable (3) and the backlight cable (4) from the display inverter.

12. Remove the display inverter.
Reverse this procedure to install the display inverter.
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Hard drive
Description

Spare part number

250-GB, 5400-rpm hard drive

458219-001

200-GB, 7200-rpm hard drive

461876-001

160-GB, 7200-rpm hard drive

460282-001

160-GB, 5400-rpm hard drive

450495-001

120-GB, 7200-rpm hard drive

454987-001

120-GB, 5400-rpm hard drive

450494-001

100-GB, 7200-rpm hard drive

450493-001

80-GB, 7200-rpm hard drive

450497-001

80-GB, 5400-rpm hard drive

450496-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

Remove the hard drive:
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1.

Position the computer with the front toward you.

2.

Loosen the two Phillips PM2.0×17.0 captive screws (1) that secure the hard drive cover to the
computer.
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3.

Lift the right side of the hard drive cover (2), swing it to left, and remove the cover. The hard drive
cover is included in the Plastics Kit, spare part number 450585-001.

4.

Loosen the Phillips PM2.5×13.0 captive screw (1) that secures the hard drive to the computer.

5.

Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.

6.

Remove the hard drive (4) from the hard drive bay.

7.

If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.
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8.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module
Description

Spare part number

Bluetooth module (includes Bluetooth module cable)

450485-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the hard drive (see Hard drive on page 48).

Remove the Bluetooth® module:
1.

Position the computer with the rear panel toward you.

2.

Release the Bluetooth module (1) from the clip in the hard drive bay by sliding it forward.

3.

Remove the Bluetooth module (2) from the hard drive bay by lifting it straight up.

4.

Disconnect the Bluetooth module cable (3) from the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.
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Primary memory module
Description

Spare part number

4096-MB (PC2-5300, 667-MHz, DDR2)

469650-001

2048-MB (PC2-5300, 667-MHz, DDR2)

450576-001

1024-MB (PC2-5300, 667-MHz, DDR2)

450575-001

512-MB (PC2-5300, 667-MHz, DDR2)

450577-001

Before removing the primary memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

Remove the primary memory module:
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1.

Loosen the three Phillips PM2.5×5.0 captive screws (1) that secure the memory module/WLAN
module compartment cover to the computer.

2.

Lift the front edge of the cover (2), swing it up and forward, and remove the cover. The memory
module/WLAN module compartment cover is included in the Plastics Kit, spare part number
450585-001.

3.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the primary memory module.
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WLAN module
Description

Spare part number

Intel 802.11a/b/g/n WLAN modules:
●

For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441086-003

●

For use in Japan

441086-291

●

For use in South Korea

441086-AD1

Broadcom 802.11a/b/g WLAN modules:
●

For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the United
States

441075-001

●

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
& Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

●

For use in Japan

441075-291

Intel 802.11a/b/g WLAN modules:
●
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For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam
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441082-001

Description

Spare part number

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441082-003

●

For use in Japan

441082-291 and
441082-292

802.11b/g Broadcom WLAN modules:
●

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

●

441090-002
For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

●

For use in Japan

441090-001

441090-291

802.11b/g Intel WLAN module for use in Thailand

448675-004

Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the memory module/WLAN module compartment cover (see Primary memory module
on page 52).
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Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is connected
to the middle terminal on the WLAN module.

2.

Remove the two Phillips PM2.0×3.0 screws (3) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3.

Remove the WLAN module (4) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.
Description

Spare part number

RTC battery

450478-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the memory module/WLAN module compartment cover (see Primary memory module
on page 52).

Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

2.

Remove the RTC battery (2) from the clip built into the base enclosure.

Reverse this procedure to install the RTC battery.
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Optical drive
Description

Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

450490-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

450491-001

DVD/CD-RW Combo Drive

450492-001

Blu-ray DVD-RW Drive

450489-001

DVD-ROM Drive

450488-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

Remove the optical drive:
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1.

Position the computer with the left side toward you.

2.

Remove the Phillips PM2.5×9.0 screw (1) that secures the optical drive to the computer.

3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4.

Remove the optical drive (3).

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.
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6.

Remove the two Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.
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Keyboard
For use in:

Spare part number

For use in:

Spare part number

Keyboards with pointing stick (includes pointing stick cable):
Belgium

450471-A41

Norway

450471-091

Brazil

450471-201

Portugal

450471-131

The Czech Republic

450471-221

Russia

450471-251

Denmark

450471-081

Saudi Arabia

450471-171

France

450471-051

Slovakia

450471-231

French Canada

450471-121

Slovenia

450471-AD1

Germany

450471-041

South Korea

450471-BA1

Greece

450471-151

Spain

450471-071

Hungary

450471-211

Sweden and Finland

450471-B71

Iceland

450471-DD1

Switzerland

450471-111

Israel

450471-BB1

Taiwan

450471-AB1

Italy

450471-061

Thailand

450471-281

Japan

450471-291

Turkey

450471-141

Latin America

450471-161

The United Kingdom

450471-031

The Netherlands and Europe

450471-021

The United States

450471-001

Belgium

450472-A41

Norway

450472-091

Brazil

450472-201

Portugal

450472-131

The Czech Republic

450472-221

Russia

450472-251

Denmark

450472-081

Saudi Arabia

450472-171

France

450472-051

Slovakia

450472-231

French Canada

450472-121

Slovenia

450472-AD1

Germany

450472-041

South Korea

450472-BA1

Greece

450472-151

Spain

450472-071

Hungary

450472-211

Sweden and Finland

450472-B71

Iceland

450472-DD1

Switzerland

450472-111

Israel

450472-BB1

Taiwan

450472-AB1

Italy

450472-061

Thailand

450472-281

Japan

450472-291

Turkey

450472-141

Latin America

450472-161

The United Kingdom

450472-031

The Netherlands and Europe

450472-021

The United States

450472-001

Keyboards without pointing stick:
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Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

Remove the keyboard:
1.

Position the computer with the front toward you.

2.

Loosen the four Phillips PM2.5×9.0 captive screws that secure the keyboard to the computer.

3.

Open the computer, and rest it on its right side.
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4.

Lift the upper left corner of the keyboard (1) and swing the left side of the keyboard (2) forward.

5.

Turn the computer right-side up, with the front toward you.

6.

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

7.

Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

8.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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Expansion memory module
Description

Spare part number

4096-MB (PC2-5300, 667-MHz, DDR2)

469650-001

2048-MB (PC2-5300, 667-MHz, DDR2)

450576-001

1024-MB (PC2-5300, 667-MHz, DDR2)

450575-001

512-MB (PC2-5300, 667-MHz, DDR2)

450577-001

Before removing the expansion memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

Remove the expansion memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the expansion memory module.
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TouchPad
NOTE:

All TouchPad spare part kits include a TouchPad cable.

Description

Spare part number

For use with keyboards with a pointing stick, includes 3 pointing stick buttons and 3 TouchPad
buttons

450597-001

For use with keyboards without a pointing stick, includes 2 TouchPad buttons

450596-001

Before removing the TouchPad, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

Remove the TouchPad:
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1.

Turn the computer upside down, with the front toward you.

2.

Remove the Torx T8M2.5×9.0 screw that secures the TouchPad to the computer.

3.

Turn the computer right-side up, with the front toward you.

4.

Disconnect the TouchPad cable (1) from the system board.
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5.

Lift the rear edge of the TouchPad (2) until it disengages from the top cover.

6.

Remove the TouchPad.

Reverse this procedure to install the TouchPad.
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Modem module
Description

Spare part number

Modem module

443899-001

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

6.

Remove the TouchPad (see TouchPad on page 64).

Remove the modem module:
1.

Remove the two Phillips PM2.0×4.0 screws (1) that secure the modem module to the system board.

2.

Disconnect the modem module (2) from the system board by lifting it straight up.

3.

Disconnect the modem module cable (3) from the modem module.

4.

Remove the modem module.

Reverse this procedure to install the modem module.
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Switch cover
Description

Spare part number

Switch cover (includes LED board and cable)

450479-001

Before removing the switch cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

Remove the switch cover:
1.

Turn the computer upside down, with the rear panel toward you.

2.

Remove the four Torx T8M2.5×4.0 screws that secure the switch cover to the computer.

3.

Turn the computer right-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Disconnect the power button board cable (1) from the system board.
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6.

Lift the front edge of the switch cover (2) until it disengages from the computer.

7.

Release the ZIF connector (1) to which the LED board cable is connected and disconnect the cable
from the system board.

8.

Remove the switch cover (2).

Reverse this procedure to install the switch cover.
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Power button board
Description

Spare part number

Power button board (includes cable)

450481-001

Before removing the power button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

6.

Remove the switch cover (see Switch cover on page 67).

Remove the power button board:
1.

Turn the switch cover upside down, with the front toward you.

2.

Remove the Torx T8M2.5×4.0 screw (1) that secures the power button board to the switch cover.

3.

Remove the power button board (2).

Reverse this procedure to install the power button board.
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Fan/heat sink assembly
Description

Spare part number

Fan/heat sink assembly (includes replacement thermal material)

450594-001

Before removing the fan/heat sink assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

6.

Remove the switch cover (see Switch cover on page 67).

Remove the fan/heat sink assembly:
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1.

Disconnect the fan cable (1) from the system board.

2.

Remove the Torx T8M2.5×7.0 screw (2) that secures the fan/heat sink assembly to the computer.

3.

Loosen the four Torx T8M2.0×10.0 screws (3) that secure the fan/heat sink assembly to the
computer.

4.

Lift the front edge of the fan/heat sink assembly (1) to disengage it from the system board and
graphics card.
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5.

Remove the fan/heat sink assembly (2) by sliding it forward.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics card (1)
and fan/heat sink assembly(2) each time the fan/heat sink assembly is removed. Thermal material is
included with all fan/heat sink assembly and graphics card spare part kits.

Reverse this procedure to reassemble and install the fan/heat sink assembly.
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Graphics card
NOTE:

All graphics card spare part kits include replacement thermal material.

Description

Spare part number

For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468952-001

For use only with HP Compaq 8710w computer models with processors with 2- or 4-MB L2 cache
(nVidia NB8E-GLM graphics card with 512 MB graphics subsystem memory operating at 800 MHz)

451377-001

For use only with HP Compaq 8710p computer models with processors with 2- or 4-MB L2 cache
(nVidia NB8P-NVS2 graphics card with 256 MB of graphics subsystem memory operating at 700
MHz; supports TurboCache)

450484-001

Before removing the graphics card, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 60)

b.

Switch cover (see Switch cover on page 67)

c.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)

Remove the graphics card:
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1.

Remove the two HM5.0×10.0 standoffs (1) that secure the graphics card to the system board.

2.

Lift the front edge of the graphics card (2) until it clears the adjacent edge of the top cover.
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3.

Remove the graphics card (3) by sliding it away from the graphics card slot at an angle.
NOTE:

The graphics card is designed with a notch (4) to prevent incorrect installation.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics
card (1) and fan/heat sink assembly(2) each time the fan/heat sink assembly is removed. Thermal
material is included with all fan/heat sink assembly and graphics card spare part kits.

Reverse this procedure to install the graphics card.
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Heat sink
NOTE:

Replacement thermal material is included with all heat sink spare part kits.

Description

Spare part number

For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468593-001

For use only with computer models equipped with processors with 2- or 4-MB L2 cache

450593-001

Before removing the processor heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 60)

b.

Switch cover (see Switch cover on page 67)

c.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)

Remove the processor heat sink:
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1.

Loosen the four Phillips PM2.5×7.0 screws (1) that secure the processor heat sink to the base
enclosure.

2.

Lift the right side of the processor heat sink (2) until it disengages from the processor.

3.

Release the processor heat sink (3) by sliding it to the right until it clears the base enclosure.

4.

Remove the processor heat sink.
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Reverse this procedure to install the processor heat sink.
NOTE: The thermal material must be thoroughly cleaned from the surfaces of the processor heat
sink (1) and the processor (2) each time the processor heat sink is removed. Thermal material is included
with all processor heat sink and processor spare part kits.

Processor
NOTE:

Replacement thermal material is included with all processor spare part kits.

Description

Spare part number

Intel Core 2 Duo T9500 2.6-GHz processor (6-MB L2 cache, 800-MHz FSB)

463051-001

Intel Core 2 Duo T9300 2.5-GHz processor (6-MB L2 cache, 800-MHz FSB)

463050-001

Intel Core 2 Duo T8300 2.4-GHz processor (3-MB L2 cache, 800-MHz FSB)

463049-001

Intel Core 2 Duo T8100 2.1-GHz processor (3-MB L2 cache, 800-MHz FSB)

463048-001

Intel Core 2 Duo T7800 2.6-GHz processor (4-MB L2 cache, 800-MHz FSB)

458218-001

Intel Core 2 Duo T7700 2.4-GHz processor (4-MB L2 cache, 800-MHz FSB)

450589-001

Intel Core 2 Duo T7500 2.2-GHz processor (4-MB L2 cache, 800-MHz FSB)

450588-001

Intel Core 2 Duo T7300 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB)

450587-001

Intel Core 2 Duo T7250 2.0-GHz processor (4-MB L2 cache, 800-MHz FSB)

460283-001

Intel Core 2 Duo T7100 1.8-GHz processor (2-MB L2 cache, 800-MHz FSB)

450586-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 44).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 60)

b.

Switch cover (see Switch cover on page 67)

c.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)

d.

Processor heat sink (see Heat sink on page 74)

Remove the processor:
1.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

2.

Lift the processor (2) straight up and remove it.
NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed on
the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly
NOTE:

All display assembly spare part kits include 3 WLAN antenna transceivers and cables.

Description

Spare part number

17.0-inch, WUXGA+ WVA AntiGlare display assembly

450582-001

17.0-inch, WSXGA+ WVA AntiGlare display assembly

450580-001

17.0-inch, WSXGA+ WVA BrightView display assembly

450581-001

17.0-inch, WXGA+ AntiGlare display assembly

450583-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 44).

5.

Remove the keyboard (see Keyboard on page 60).

6.

Remove the switch cover (see Switch cover on page 67).

Remove the display assembly:
1.

Turn the computer upside down, with the rear panel toward you.

2.

Remove the two Torx T8M2.5×9.0 screws (1) from the rear panel that secure the display assembly
to the computer.

3.

Remove the three Torx T8M2.5×9.0 screws (2) from the base enclosure that secure the display
assembly to the computer.

4.

Turn the computer right-side up, with the front toward you.
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5.

Disconnect the display panel cable (1) from the system board.

6.

Remove the wireless antenna cables, the microphone cable, and the microphone extension cable
from the clips (2) and routing channels built into the top cover.

7.

Disconnect the microphone cable (3) from the microphone extension cable.

8.

Open the computer as far as possible.

9.

Remove the two Torx T8M2.5×4.0 screws (1) that secure the display assembly to the computer.

10. Lift the display assembly (2) straight up and remove it.
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11. If it is necessary to replace the display bezel or display hinges, remove the rubber screw covers
listed below. All rubber screw covers are included in the Display Rubber Kit, spare part number
450573-001.
NOTE: See Display inverter and ambient light sensor board on page 45 for display inverter and
ambient light sensor board replacement instructions.
(1) Two rounded rubber screw covers on the display bezel top edge corners
(2) Two flat rubber screw covers on the display bezel bottom edge corners
(3) Two small oblong rubber screw covers on the display bezel top edge
(4) Two large oblong rubber screw covers on the display bezel top edge

12. Remove the following screws:
(1) Six Phillips PM2.5×7.0 screws
(2) Two Phillips PM2.0×6.0 screws
(3) Two stabilizer clips
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13. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.
14. Remove the display bezel (3). The display bezel is available using spare part number 450500-001.

15. Remove the four mylar screw covers (1) from the left and right sides of the display enclosure.
16. Remove the four Torx T8M2.5×4.0 screws (2) that secure the display panel to the display enclosure.
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17. Remove the following screws:
(1) Two Torx T8M2.5×4.0 screws on the display panel top edge
(2) Two Torx T8M2.5×7.0 screws on the display panel bottom edge
(3) One Torx T8M2.5×4.0 screw that secures the ambient light sensor to the display enclosure
(4) One Torx T8M2.5×4.0 screw that secures the display inverter to the display enclosure

18. Remove the display panel from the display enclosure.

19. Remove the four Phillips PM2.0×4.0 screws (1) that secure each display hinge to the display
panel.
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20. Remove the display hinges (2). The left and right display hinges are included in the Display Bracket
Kit, spare part number 450570-001.

Reverse this procedure to reassemble and install the display assembly.

82

Chapter 4 Removal and replacement procedures

Top cover
NOTE:

All top cover spare part kits include a fingerprint reader board and cable.

Description

Spare part number

For use only with HP Compaq 8710w computer models

451379-001

For use only with HP Compaq 8710p computer models

450595-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the following components:
a.

Battery (see Battery on page 44)

b.

Keyboard (see Keyboard on page 60)

c.

Switch cover (see Switch cover on page 67)

d.

Display assembly (see Display assembly on page 77)

Remove the top cover:
1.

Turn the computer upside down, with the front toward you.

2.

Remove the fourteen Torx T8M2.5×9.0 screws that secure the top cover to the base enclosure.

3.

Turn the computer right-side up, with the front toward you.
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4.

Disconnect the fingerprint reader board cable from the system board.

5.

Remove the three Torx T8M2.5×7.0 screws that secure the top cover to the computer.

6.

Lift the rear edge of the top cover (1) until it rests at an angle.

7.

Swing the rear edge of the top cover (2) up and forward until it disengages from the base enclosure.
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8.

Remove the top cover (3).

Reverse this procedure to install the top cover.

Speaker assembly
Description

Spare part number

Speaker assembly

450592-001

Before removing the speaker assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the following components:
a.

Battery (see Battery on page 44)

b.

Keyboard (see Keyboard on page 60)

c.

Switch cover (see Switch cover on page 67)

d.

Display assembly (see Display assembly on page 77)

e.

Top cover (see Top cover on page 83)

Remove the speaker assembly:
1.

Disconnect the speaker cable (1) from the system board.

Component replacement procedures

85

2.

Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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System board
NOTE:

Replacement thermal material is included with all system board spare part kits.

Description

Spare part number

For use only with computer models equipped with processors with 3- or 6-MB L2 cache

468591-001

For use only with computer models equipped with processors with 2- or 4-MB L2 cache

450482-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the following components:
a.

Battery (see Battery on page 44)

b.

Hard drive (see Hard drive on page 48)

c.

Bluetooth module (see Bluetooth module on page 51)

d.

Optical drive (see Optical drive on page 58)

e.

Keyboard (see Keyboard on page 60)

f.

TouchPad (see TouchPad on page 64)

g.

Switch cover (see Switch cover on page 67)

h.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)

i.

Graphics card (see Graphics card on page 72)

j.

Processor heat sink (see Heat sink on page 74)

k.

Display assembly (see Display assembly on page 77)

l.

Top cover (see Top cover on page 83)

m.

Speaker assembly (see Speaker assembly on page 85)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:
●

Memory modules (see Primary memory module on page 52 and Expansion memory module
on page 63)

●

WLAN module (see WLAN module on page 54)

●

RTC battery (see RTC battery on page 57)

●

Modem module (see Modem module on page 66)
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●

Processor (see Processor on page 75)

●

PC Card assembly (see PC Card assembly on page 92)

Remove the system board:
1.

Turn the computer upside down, with the front toward you.

2.

Remove the Torx T8M2.5×4.0 screw that secures the system board to the base enclosure.

3.

Turn the computer right-side up, with the front toward you.

4.

Disconnect the following cables from the system board:
(1) RJ-45 connector cable
(2) Modem module cable
(3) Bluetooth module cable
(4) USB/audio board cable

5.
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Remove the modem module cable (5) from the clip in the system board.
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6.

Remove the two Torx T8M2.5×7.0 screws (1) that secure the system board to the base enclosure.

7.

Use the optical drive connector (2) to lift the right side of the system board (3) until it rests at an
angle.

8.

Remove the system board (4) by sliding it away from the base enclosure at an angle.

9.

If it is necessary to replace the Bluetooth module cable, remove the cable (1) from the clips (2)
and (3) built into the base enclosure. The Bluetooth module cable is included in the Cable Kit, spare
part number 450486-001.
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10. If it is necessary to replace the microphone extension cable, disconnect the cable (1), push the
cable from the clips (2), and remove the cable(3). The microphone extension cable is available
using spare part number 450578-001.

11. If it is necessary to replace the RJ-11 connector cable, remove the RJ-11 connector (1) from the
clip built into the base enclosure.
12. Remove the RJ-11 connector cable (2) from the clips and routing channel built into the base
enclosure. The RJ-11 connector cable is included in the Cable Kit, spare part number 450486-001.

13. If it is necessary to replace the RJ-45 connector cable, remove the RJ-45 connector (1) from the
clip built into the base enclosure. The RJ-45 connector cable is included in the Cable Kit, spare
part number 450486-001
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14. Remove the RJ-45 connector cable (2) from the clips and routing channel built into the base
enclosure.

Reverse the preceding procedure to install the system board, Bluetooth module cable, microphone
extension cable, RJ-11 cable, and RJ-45 cable.

USB/audio board
Description

Spare part number

USB/audio board (includes 2-into-1 USB board cable and audio board cable)

450483-001

Before removing the USB/audio board, follow these steps:
1.

Battery (see Battery on page 44)

2.

Hard drive (see Hard drive on page 48)

3.

Bluetooth module (see Bluetooth module on page 51)

4.

Optical drive (see Optical drive on page 58)

5.

Keyboard (see Keyboard on page 60)

6.

TouchPad (see TouchPad on page 64)

7.

Switch cover (see Switch cover on page 67)

8.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)

9.

Graphics card (see Graphics card on page 72)

10. Processor heat sink (see Heat sink on page 74)
11. Display assembly (see Display assembly on page 77)
12. Top cover (see Top cover on page 83)
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13. Speaker assembly (see Speaker assembly on page 85)
14. System board (see System board on page 87)
Remove the USB/audio board:
1.

Remove the USB/audio board cables (1) from the clips (2) built into the base enclosure.

2.

Remove the Torx T8M2.5×4.0 screw (3) that secures the USB/audio board to the base enclosure.

3.

Lift the left side of the USB/audio board (4) until the USB and audio connectors disengage from
the openings in the base enclosure.

4.

Remove the USB/audio board and cables from the base enclosure.

Reverse this procedure to install the USB/audio board.

PC Card assembly
Description

Spare part number

PC Card assembly

450584-001

Before removing the PC Card assembly, follow these steps:
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1.

Battery (see Battery on page 44)

2.

Hard drive (see Hard drive on page 48)

3.

Bluetooth module (see Bluetooth module on page 51)

4.

Optical drive (see Optical drive on page 58)

5.

Keyboard (see Keyboard on page 60)

6.

TouchPad (see TouchPad on page 64)

7.

Switch cover (see Switch cover on page 67)

8.

Fan/heat sink assembly (see Fan/heat sink assembly on page 70)
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9.

Graphics card (see Graphics card on page 72)

10. Processor heat sink (see Heat sink on page 74)
11. Display assembly (see Display assembly on page 77)
12. Top cover (see Top cover on page 83)
13. Speaker assembly (see Speaker assembly on page 85)
14. System board (see System board on page 87)
Remove the PC Card assembly:
1.

Turn the system board upside down, with the PC Card eject button toward you.

2.

Remove the four Phillips PM2.0×4.0 screws that secure the PC Card assembly to the system board.

3.

Remove the PC Card assembly from the system board.

Reverse this procedure to install the PC Card assembly.
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5

Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.
NOTE: An external keyboard and pointing stick connected by USB can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup:
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1.

Turn on or restart the computer.

2.

Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.
Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:
●

To choose a menu or a menu item, use the arrow keys.

●

To select an item, press enter.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc.

●

To view navigation information, press f1.

●

To change the language, press f2.

2.

Select the File, Security, Diagnostics, or System Configuration menu.

3.

To exit Computer Setup, choose one of the following methods:
●

To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

●

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2.

Use the arrow keys to select File > Restore defaults, and then press enter.

3.

When the confirmation dialog box opens, press f10.

4.

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Using Computer Setup
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu
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Select

To do this

System information

●

View identification information for the computer and the batteries in the
system.

●

View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard and pointing stick controller
version.

Restore defaults

Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit

Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit

Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu
Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-On password

Enter, change, or delete a power-on password.

Password options

●

Enable/disable stringent security.

●

Enable/disable password requirement on computer restart.

●

Enable/disable DriveLock on any computer hard drive.

●

Change a DriveLock user password or master password.

DriveLock passwords

NOTE: DriveLock settings are accessible only when you enter Computer Setup
by turning on (not restarting) the computer.
Smart Card security

Enable/disable support for smart card and Java™ Card power-on authentication.
NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.
NOTE:

TPM Embedded Security

You must have an administrator password to change this setting.

Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions
available in Embedded Security for ProtectTools. For more information, refer to
the ProtectTools software Help.
NOTE:

You must have a setup password to change this setting.

System IDs

Enter user-defined and pointing stick computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:
●

Fast: Runs the Disk Sanitizer erase cycle once.

●

Optimum: Runs the Disk Sanitizer erase cycle 3 times.

●

Custom: Allows you to select the desired number of Disk Sanitizer erase
cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu
Select

To do this

Hard Drive Self-Test options

Run a comprehensive self-test on any hard drive in the system.

Memory Check

Run a comprehensive check on system memory.

Startup Check (select models only)

Verify the system components needed for starting the computer.
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System Configuration menu
NOTE:

Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language (or press f2)

Change the Computer Setup language.

Boot options

●

Set f9, f10, and f12 delay when starting up.

●

Enable/disable CD-ROM boot.

●

Enable/disable floppy boot.

●

Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

●

Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

●

Set the Express Boot Popup delay in seconds.

●

Set the boot order.

●

Swap the functions of the fn key and left ctrl key.

●

Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

●

Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

Device configurations
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◦

Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦

Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer or to an
optional docking device (select models only).

●

Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

●

Enable/disable BIOS DMA data transfers.

●

Enable/disable fan always on while connected to an AC outlet.

●

Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code
execution, which helps to improve computer security.

●

Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

●

Enable/disable SATA Native Mode.

●

Enable/disable Dual Core CPU.

●

Enable/disable Secondary Battery Fast Charge.

●

Choose Bit-shift or LBA assisted HDD Translation Mode.

●

Enable/disable Windows direct application launcher.

●

Enable/disable HP Lockout.

Select

To do this

Built-In Device Options

●

Enable/disable embedded WWAN Device Radio.

●

Enable/disable embedded WLAN Device Radio.

●

Enable/disable embedded Bluetooth® Device Radio.

●

Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

●

Enable/disable Wake on LAN from Off.

●

Enable/disable the ambient light sensor.

●

Enable/disable the serial port.

●

Enable/disable the parallel port.

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.

Port Options

CAUTION: Disabling the USB port also disables MultiBay II devices and
ExpressCard devices on the advanced port replicator.
●

Enable/disable the 1394 port.

●

Enable/disable the cardbus slot.

●

Enable/disable the ExpressCard slot.

●

Enable/disable the infrared port.

●

Enable/disable the optical disk drive.

●

Enable/disable the network controller.

Computer Setup menus
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Specifications

Computer specifications
Metric

U.S.

Length

27.5 cm

10.8 in

Width

39.3 cm

15.5 in

Height (front to rear)

3.3 to 3.9 cm

1.3 to 1.5 in

Weight (equipped with 8-cell battery, 80-GB/5400-rpm hard
drive, optical drive, one 1024-MB memory module, WLAN
module, pointing stick, TouchPad, and nVidia GM84 graphics
card; varies by configuration)

3.4 kg

7.5 lbs

Dimensions

Input power
Operating voltage

19.0 V dc @ 4.74 A – 120 W

Operating current

4.74 A

Temperature
Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating
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0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Metric
Nonoperating

U.S.

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

17.0-inch, WUXGA+WVA display specifications
Metric

U.S.

Height

24.4 cm

9.65 in

Width

38.1 cm

15.0 in

Diagonal

43.2 cm

17.0 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.172 × 0.172 mm

Format

1920 × 1200

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25

Total power consumption

6.0 W

Viewing angle

+/-65 horizontal, +/-50° vertical (typical)
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17.0-inch, WSXGA+WVA display specifications
Metric

U.S.

Height

24.4 cm

9.6 in

Width

38.1 cm

15.0 in

Diagonal

43.2 cm

17.0 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.172 × 0.172 mm

Format

1680 × 1050

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25

Total power consumption

7.0 W

Viewing angle

+/-60 horizontal, +40/-50° vertical (typical)
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17.0-inch, WXGA+WVA display specifications
Metric

U.S.

Height

24.4 cm

9.6 in

Width

38.1 cm

15.0 in

Diagonal

43.2 cm

17.0 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.259 × 0.259 mm

Format

1440× 900

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25

Total power consumption

6.5 W

Viewing angle

+/-45° horizontal, +15/-35° vertical (typical)
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Hard drive specifications
250-GB*

200-GB*

160-GB*

120-GB*

100-GB*

80-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

ATA security

ATA security

Dimensions

Seek times (typical read, including setting)
Single track

3 ms

3 ms

3 ms

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

24 ms

24 ms

24 ms

Logical blocks

488,376,120

390,700,080

312,560,340

234,420,480

195,350,400

156,280,320

Disk rotational speed

5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

7200 and
5400 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW Double-Layer Combo Drive
specifications
Applicable disc

Center hole diameter

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CDRW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW
DVD+R, DVD+RW, DVD-R, DVDRW, DVD-RAM

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Full stroke

< 285 ms

< 335 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD-ROM

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds
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DVD/CD-RW Combo Drive specifications
Applicable disc

Center hole diameter

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CDRW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 110 ms

< 130 ms

Full stroke

< 210 ms

< 225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

3,600 KB/sec

24X CD-R

3,600 KB/sec

24X CD-RW

3,600 KB/sec

Transfer mode

Multiword DMA mode 2

Startup time

< 15 seconds

Stop time

< 6 seconds
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DVD-ROM Drive
Applicable disc

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 100 ms

< 125 ms

Full stroke

< 175 ms

< 225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

512 KB

Data transfer rate
CD-R (24X)

3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X)

1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2

16.6 MB/s

Startup time

< 10 seconds

Stop time

< 3 seconds
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System DMA specifications
Hardware DMA

System function

DMA0

Not applicable

DMA1*

Not applicable

DMA2*

Not applicable

DMA3

Not applicable

DMA4

Direct memory access controller

DMA5*

Available for PC Card

DMA6

Not assigned

DMA7

Not assigned

*PC Card controller can use DMA 1, 2, or 5.

System memory map specifications
Size

Memory address

System function

640 KB

00000000-0009FFFF

Base memory

128 KB

000A0000-000BFFFF

Video memory

48 KB

000C0000-000CBFFF

Video BIOS

160 KB

000C8000-000E7FFF

Unused

64 KB

000E8000-000FFFFF

System BIOS

15 MB

00100000-00FFFFFF

Extended memory

58 MB

04800000-07FFFFFF

Super extended memory

58 MB

04800000-07FFFFFF

Unused

2 MB

08000000-080FFFFF

Video memory (direct access)

4 GB

08200000-FFFEFFFF

Unused

64 KB

FFFF0000-FFFFFFFF

System BIOS
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System interrupt specifications
Hardware IRQ

System function

IRQ0

System timer

IRQ1

Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2

Cascaded

IRQ3

Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4

COM1

IRQ5*

Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6

Diskette drive

IRQ7*

Parallel port

IRQ8

System CMOS/real-time clock

IRQ9*

Microsoft ACPI-compliant system

IRQ10*

Intel USB UHCI controller—24C2
Intel 82852/82855 GM/GME Graphic Controller
Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11

Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12

Synaptics PS/2 TouchPad

IRQ13

Numeric data processor

IRQ14

Primary IDE channel

IRQ15

Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.
NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex)

System function (shipping configuration)

000 - 00F

DMA controller no. 1

010 - 01F

Unused

020 - 021

Interrupt controller no. 1

022 - 024

Opti chipset configuration registers

025 - 03F

Unused

02E - 02F

87334 “Super I/O” configuration for CPU

040 - 05F

Counter/timer registers

044 - 05F

Unused

060

Keyboard controller

061

Port B

062 - 063

Unused

064

Keyboard controller

065 - 06F

Unused

070 - 071

NMI enable/RTC

072 - 07F

Unused

080 - 08F

DMA page registers

090 - 091

Unused

092

Port A

093 - 09F

Unused

0A0 - 0A1

Interrupt controller no. 2

I/O Address (hex)

System Function (shipping configuration)

0A2 - 0BF

Unused

0C0 - 0DF

DMA controller no. 2

0E0 - 0EF

Unused

0F0 - 0F1

Coprocessor busy clear/reset

0F2 - 0FF

Unused

100 - 16F

Unused

170 - 177

Secondary fixed disk controller

178 - 1EF

Unused

1F0 - 1F7

Primary fixed disk controller

1F8 - 200

Unused

201

JoyStick (decoded in ESS1688)

202 - 21F

Unused
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I/O address (hex)

System function (shipping configuration)

220 - 22F

Entertainment audio

230 - 26D

Unused

26E - 26

Unused

278 - 27F

Unused

280 - 2AB

Unused

2A0 - 2A7

Unused

2A8 - 2E7

Unused

2E8 - 2EF

Reserved serial port

2F0 - 2F7

Unused

2F8 - 2FF

Infrared port

300 - 31F

Unused

320 - 36F

Unused

370 - 377

Secondary diskette drive controller

378 - 37F

Parallel port (LPT1/default)

380 - 387

Unused

388 - 38B

FM synthesizer—OPL3

38C - 3AF

Unused

3B0 - 3BB

VGA

3BC - 3BF

Reserved (parallel port/no EPP support)

3C0 - 3DF

VGA

3E0 - 3E1

PC Card controller in CPU

3E2 - 3E3

Unused

3E8 - 3EF

Internal modem

3F0 - 3F7

“A” diskette controller

3F8 - 3FF

Serial port (COM1/default)

CF8 - CFB

PCI configuration index register (PCIDIVO-1)

CFC - CFF

PCI configuration data register (PCIDIVO-1)
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Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
450591-001, and the Display Screw Kit, spare part number 450574-001.
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Phillips PM2.0×17.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

2

17.0 mm

2.0 mm

5.0 mm

Where used: 2 captive screws that secure the hard drive cover to the computer (screws are captured
on the cover by C-clips)

Phillips PM2.0×17.0 captive screw 113

Phillips PM2.5×13.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

1

13.0 mm

2.5 mm

5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is captured on the
hard drive bracket)
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Phillips PM3.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

4

4.0 mm

3.0 mm

5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive

Phillips PM3.0×4.0 screw 115

Phillips PM2.5×5.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

3

5.0 mm

2.5 mm

5.0 mm

Where used: 3 captive screws that secure the memory module/WLAN module compartment cover to
the computer (screws are captured on the cover by C-clips)
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Phillips PM2.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

18

4.0 mm

2.0 mm

4.5 mm

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the optical drive bracket to the optical drive

Phillips PM2.0×4.0 screw 117

Where used: 2 screws that secure the modem module to the system board

Where used: 8 screws that secure the display hinges to the display panel

Where used: 4 screws that secure the PC Card assembly to the system board

118 Chapter 7 Screw listing

Torx TM2.5×9.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

21

9.0 mm

2.5 mm

5.0 mm

Where used:
(1) One screw that secures the optical drive to the computer
(2) One screw that secures the TouchPad to the computer
(3) Five screws that secure the display assembly to the computer

Torx TM2.5×9.0 screw 119

Where used: 14 screws that secure the top cover to the computer
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Torx TM2.5×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

16

4.0 mm

2.5 mm

4.5 mm

Where used: 4 screws that secure the switch cover to the base enclosure

Where used: One screw that secures the power button board to the switch cover

Torx TM2.5×4.0 screw 121

Where used: 2 screws that secure the display assembly to the computer

Where used: 4 screws that secure the display panel to the display enclosure

Where used:
(1) Two screws that secure the display panel to the display enclosure
(2) One screw that secures the ambient light sensor to the display enclosure
(3) One screw that secures the display inverter to the display enclosure
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Where used: One screw that secures the system board to the base enclosure

Torx TM2.5×4.0 screw 123

Phillips PM2.5×9.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

4

9.0 mm

2.5 mm

5.0 mm

Where used: 3 captive screws that secure the keyboard to the computer
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Torx T8M2.5×7.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

9

7.0 mm

2.5 mm

5.0 mm

Where used: One screw that secures the fan/heat sink assembly to the computer

Where used: 2 screws that secure the display panel to the display enclosure

Torx T8M2.5×7.0 screw 125

Where used: 3 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the system board to the base enclosure

Where used: One screw that secures the USB/audio board to the base enclosure
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Phillips PM2.5×7.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

6

7.0 mm

2.5 mm

5.0 mm

Where used: 6 screws that secure the display bezel to the display enclosure

Phillips PM2.5×7.0 screw 127

Torx T8M2.0×10.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

4

10.0 mm

2.0 mm

5.0 mm

Where used: 4 captive screws that secure the fan/heat sink assembly to the system board

128 Chapter 7 Screw listing

Hex Metric HM5.0×10.0 standoff

Color

Quantity

Length

Thread

Head diameter

Silver

2

10.0 mm

2.5 mm

5.0 mm

Where used: 2 standoffs that secure the graphics card to the system board

Hex Metric HM5.0×10.0 standoff 129

Phillips PM2.5×7.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

4

7.0 mm

2.5 mm

5.0 mm

Where used: 4 captive screws that secure the processor heat sink to the base enclosure
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Phillips PM2.0×6.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

2

6.0 mm

2.0 mm

5.0 mm

Where used: 2 screws that secure the display bezel to the display enclosure
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Backup and recovery

Backup and recovery using Windows Vista
Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.
Note the following guidelines before creating recovery discs:
●

Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in your
computer. Because DVDs store more information than CDs, DVDs and DVDs with double-layer
(DL) support reduce the number of discs required.
NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup & Recovery Manager software.

●

The computer must be connected to AC power during the process.

●

Only one set of the recovery discs can be created per computer.

●

Number each disc before inserting it into the optical drive of the computer.

●

If necessary, you can cancel the disc creation before you have finished and pointing stick creating
the recovery discs. The next time you select Create a set of recovery discs (Recommended),
you will be prompted to continue the disc creation.

To create a set of recovery discs:
1.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2.

Click Next.

3.

Click Create a set of recovery discs (Recommended), and then click Next.

4.

Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.
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With HP Backup & Recovery Manager, you can perform the following tasks:
●

Backing up your information regularly to protect your important system files

●

Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

●

Scheduling backups at specific intervals or events

When to back up
●

On a regularly scheduled basis
NOTE:

Set reminders to back up your information periodically.

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

Backup suggestions
●

Create a set of recovery discs using HP Backup & Recovery Manager.

●

Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

●

Store personal files in the Documents folder and back up these folders periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen.

b.

Copy the screen.
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.
NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).
NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.
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To back up specific files or folders:
1.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2.

Click Next.

3.

Click Create or manage backups, and then click Next.

4.

Click Back up user created files and folders, and then click Next.

5.

Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.
NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.
NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.
To back up your entire hard drive:
1.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2.

Click Next.

3.

Click Create or manage backups, and then click Next.

4.

Click Create or manage Entire Drive Backups, and then click Next.

5.

Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.
NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.
HP recommends that you create recovery points at the following times:
●

Before you add or extensively modify software or hardware

●

Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.
To create a system recovery point:
1.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2.

Click Next.

3.

Click Create or manage backups, and then click Next.

4.

Click Create or manage Recovery Points, and then click Next.

5.

Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).
To schedule backups:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2.

Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.
HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:
●

Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

●

Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup & Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:
1.

Back up all personal files.

2.

Insert the first recovery disc into the optical drive and restart the computer.

3.

Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:
●

From within Windows

●

From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:
1.

Back up all personal files.

2.

Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

3.

Click Next.

4.

Click Perform a recovery, and then click Next.

5.

Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:
1.

Back up all personal files.

2.

Restart the computer, and then press f11 before the Windows operating system loads.

3.

Click a recovery option, and then click Next.

4.

Follow the on-screen instructions.
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Backup and recovery using Windows XP
Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.
Note the following guidelines before creating recovery discs:
●

Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in your
computer. Because DVDs store more information than CDs, DVDs and DVDs with double-layer
(DL) support reduce the number of discs required.
NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup and Recovery Manager software.

●

The computer must be connected to AC power during the process.

●

Only one set of the recovery discs can be created per computer.

●

Number each disc before inserting it into the optical drive of the computer.

●

If necessary, you can cancel the disc creation before you have finished and pointing stick creating
the recovery discs. The next time you select Create factory software recovery CDs or DVDs to
recover the system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2.

Click Next.

3.

Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4.

Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.
With HP Backup and Recovery Manager, you can perform the following tasks:
●

Backing up your information regularly to protect your important system files

●

Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

●

Scheduling backups at specific intervals or events
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When to back up
●

On a regularly scheduled basis
NOTE:

Set reminders to back up your information periodically.

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

Backup suggestions
●

Create a set of recovery discs using HP Backup and Recovery Manager.

●

Create system recovery points using HP Backup and Recovery Manager, and periodically copy
them to disc.

●

Store personal files in the My Documents folder and back up these folders periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen.

b.

Copy the screen.
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.
NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).
NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.
To back up specific files or folders:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2.

Click Next.

3.

Click Back up to protect system settings and important data files, and then click Next.
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4.

Click Back up individual files and folders, and then click Next.

5.

Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.
NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.
NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.
To back up your entire hard drive:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2.

Click Next.

3.

Click Back up to protect system settings and important data files, and then click Next.

4.

Click Back up entire hard drive, and then click Next.

5.

Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.
NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.
HP recommends that you create recovery points at the following times:
●

Before you add or extensively modify software or hardware

●

Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.
To create a system recovery point:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2.

Click Next.

3.

Click Back up to protect system settings and important data files, and then click Next.

4.

Click Create or manage Recovery Points, and then click Next.

5.

Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).
To schedule backups:
1.

Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2.

Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.
HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:
●

Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

●

Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:
1.

Back up all personal files.

2.

Insert the first recovery disc into the optical drive and restart the computer.

3.

Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:
●

From within Windows

●

From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:
1.

Back up all personal files.

2.

Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

3.

Click Next.

4.

Click Recover important files or the entire system, and then click Next.

5.

Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:
1.

Back up all personal files.

2.

Restart the computer, and then press f11 before the Windows operating system loads.

3.

Click a recovery option, and then click Next.

4.

Follow the on-screen instructions.
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9

Connector pin assignments

1394

Pin

Signal

1

Twisted pair B-

2

Twisted pair B+

3

Twisted pair A-

4

Twisted pair A+

Audio-out (headphone)

Pin

Signal

1

Audio out, left channel

2

Audio out, right channel

3

Ground
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Audio-in (microphone)

Pin

Signal

1

Audio signal in

2

Audio signal in

3

Ground

External monitor

Pin

Signal

1

Red analog

2

Green analog

3

Blue analog

4

Not connected

5

Ground

6

Ground analog

7

Ground analog

8

Ground analog

9

+5 VDC

10

Ground

11

Monitor detect

12

DDC 2B data

13

Horizontal sync

14

Vertical sync

15

DDC 2B clock
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HDMI

Pin

Signal

1

TMDS data 2+

2

TMDS data 2 shield

3

TMDS data 2–

4

TMDS data 1+

5

TMDS data 1 shield

6

TMDS data 1–

7

TMDS data 0+

8

TMDS data 0 shield

9

TMDS data 0–

10

TMDS clock+

11

TMDS clock shield

12

TMDS clock–

13

CEC

14

No connect

15

DDC clock

16

DDC data

17

Ground

18

+5V power

19

Hot plug detect

20

Shell
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RJ-11 (modem)

Pin

Signal

1

Unused

2

Tip

3

Ring

4

Unused

5

Unused

6

Unused

RJ-11 (modem) 147

RJ-45 (network)

Pin

Signal

1

Transmit +

2

Transmit -

3

Receive +

4

Unused

5

Unused

6

Receive -

7

Unused

8

Unused
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Universal Serial Bus

Pin

Signal

1

+5 VDC

2

Data -

3

Data +

4

Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

Korea

EK

4

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and and pointing stick causing exposure to the mercury.
CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid and pointing stick crystal display (LCD) panel
and the backlight. Careful handling must be exercised when removing these components. When you
remove these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and and pointing stick component shapes and
sizes, can vary from one computer model to another.
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Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and and pointing stick causing exposure to the
mercury.
17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port
location 14
pin assignments 144
A
AC adapter
spare part numbers 36
AC adapter, spare part
numbers 28, 30, 36
AC adapters, spare part
numbers 30
accessory battery connector 16
ambient light sensor 7
ambient light sensor board
removal 45
spare part number 19, 34,
45
antennae
disconnecting 56
locations 7
audio, product description 3
audio-in jack
location 15
pin assignments 145
audio-out jack
location 15
pin assignments 144
B
backing up 132, 138
backup
files and folders 133, 139
hard drive 134, 140
modifications made to the
system 135, 141
scheduling 135, 141
base enclosure, spare part
number 22, 34
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battery
location 16
removal 44
spare part number 22, 34,
44
battery bay 16
battery latches 16
battery light 10, 13
Bluetooth module
removal 51
spare part number 22, 34,
51
Bluetooth module cable
illustrated 27
removal 89
boot options 98
boot order 98
bottom components 16
buttons
calculator 9
info 8
power 8
presentation 8
volume mute 8
wireless 8
C
Cable Kit
contents 27
spare part number 25, 27,
34
cables, service considerations 38
calculator button 9
caps lock light 10
carrying case, spare part
number 29, 30
chipset, product description 1
CMOS clearing 42
components
bottom 16

buttons 8
display 7
fingerprint reader 8
front 13
keys 9
left-side 14
lights 10
pointing devices 12
rear 15
right-side 15
switches 8
top 8
computer feet
locations 43
spare part number 22, 35,
43
Computer Setup
accessing 94
Diagnostics menu 97
File menu 96
navigating and selecting 95
restoring factory settings 95
Security menu 97
System Configuration
menu 98
using 95
computer specifications 100
connectors
accessory battery 16
docking 16
service considerations 38
creating recovery points 135,
141
D
Diagnostics menu 97
Disk Sanitizer 97
diskette drive
precautions 38

product description 3
spare part number 29, 30
display assembly
removal 77
spare part numbers 18, 35,
77
display bezel
release 45
removal 79
spare part number 19, 35
Display Bracket Kit, spare part
number 19, 35
display cable, spare part
number 35
display component recycling 152
display components 7
display enclosure
spare part numbers 36
display enclosure, spare part
numbers 19, 35
display hinge
removal 81
spare part number 19, 35,
82
display inverter
removal 45
spare part number 19, 35,
45
display panel
product description 2
removal 81
display panel cable, spare part
number 19
display release latch 13
Display Rubber Kit, spare part
number 19, 35
Display Screw Kit, spare part
number 19, 35
display specifications 101, 102,
103
docking connector 16
docking support, product
description 5
drive light 10, 13
DriveLock password 97
drives
boot order 98
preventing damage 38
DVD-ROM Drive
precautions 38

removal 58
spare part number 25, 28,
34
spare part numbers 29, 30,
58
specifications 107
DVD-RW Drive
precautions 38
removal 58
spare part number 24, 28,
34, 58
specifications 105
DVD/CD-RW Combo Drive
precautions 38
removal 58
spare part number 24, 28,
34
spare part numbers 29, 30,
58
specifications 106
DVD±RW and CD-RW Combo
Drive
precautions 38
removal 58
spare part numbers 24, 28,
34, 58
specifications 105
E
electrostatic discharge 39
esc key 9
Ethernet, product description 4
Execution Disable 98
external media cards, product
description 4
external monitor port
location 14
pin assignments 145
External MultiBay II power cable
and stand, spare part
number 29, 30
External MultiBay II, spare part
number 29, 30
F
fan/heat sink
spare part number 21
fan/heat sink assembly
removal 70
spare part number 35, 70

feet
locations 43
spare part number 22, 35,
43
File menu 96
fn key 9
front components 13
function keys 9
G
graphics card
removal 72
spare part numbers 22, 34,
36, 72
graphics, product description 1
grounding equipment and
methods 41
H
hard drive
location 16
precautions 38
product description 3
removal 48
spare part numbers 24, 28,
34, 36, 48
specifications 104
hard drive backup 134, 140
hard drive bay 16
hard drive bracket, removal 50
hard drive cover
illustrated 26
removal 49
hard drive recovery 136, 142
hard drive test 97
HDMI port
location 14
pin assignments 146
headphone jack
location 15
pin assignments 144
heat sink
removal 74
spare part numbers 21, 35,
36, 74
hinge
removal 81
spare part number 19, 35,
82
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HP Extended Life Battery, spare
part number 29, 30
HP Fingerprint Sensor 9
I
I/O address specifications 110
info button 8
interrupt specifications 109
inverter
removal 45
spare part number 45
J
jacks
audio-in 15
audio-out 15
headphone 15
microphone 15
modem 15
network 15
RJ-11 15
RJ-45 15
K
keyboard
product description 5
removal 60
spare part numbers 19, 20,
32, 33, 60
keypad keys 9
keys
esc 9
fn 9
function 9
keypad 9
Windows applications 9
Windows logo 9
L
Label Kit, spare part number 29,
35
LAN Power Save 98
language, changing in Computer
Setup 98
left-side components 14
legacy support, Universal Serial
Bus (USB) 94, 98
lights
battery 10, 13
caps lock 10
drive 10, 13
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num lock 10
power 10, 13
volume down 11
volume mute 11
volume up 11
wireless 10, 13

network jack
location 15
pin assignments 148
num lock light 10

M
mass storage devices, spare part
numbers 28
Media Card Reader 13
memory check 97
memory map specifications 108
memory module
product description 2
removal 52, 63
spare part numbers 22, 35,
36, 52, 63
memory module/WLAN module
compartment 16
memory module/WLAN module
compartment cover
illustrated 26
removal 52
microphone 7
microphone extension cable
illustrated 27
removal 90
spare part number 35, 90
microphone jack
location 15
pin assignments 145
microphone, product
description 3
model name 1
modem jack
location 15
pin assignments 147
modem module
product description 3
removal 66
spare part number 22, 32,
66
monitor port
location 14
pin assignments 145
N
navigating in Computer Setup

95

O
operating system, product
description 5
optical drive
location 15
precautions 38
product description 3
removal 58
spare part numbers 24, 28,
34, 58
specifications 105, 106, 107
optical drive button 15
P
packing guidelines 40
parallel port mode 98
password and pointing stick
clearing 42
passwords 97
PC Card assembly
removal 92
spare part number 21, 35,
92
PC Card eject button 14
PC Card slot 14
PC Card slot bezel, illustrated 26
pin assignments
1394 port 144
audio-in jack 145
audio-out jack 144
external monitor port 145
HDMI port 146
headphone jack 144
microphone jack 145
modem jack 147
monitor port 145
network jack 148
RJ-11 147
RJ-45 jack 148
Universal Serial Bus (USB)
port 149
plastic parts 37

Plastics Kit
contents 26
spare part number 21, 26,
35
pointing device
components 12
product description 5
pointing device components
pointing stick 12
pointing stick buttons 12
TouchPad 12
TouchPad buttons 12
TouchPad scroll zone 12
pointing stick 12
pointing stick buttons 12
ports
1394 14
external monitor port 14
HDMI 14
monitor port 14
product description 4
Universal Serial Bus
(USB) 14, 15
power button 8
power button board
removal 69
spare part number 19, 34,
69
power button board cable,
illustrated 27
power connector 14
power cord
set requirements 150
spare part numbers 29, 30
power light 10, 13
power requirements, product
description 5
power-on password 97
presentation button 8
processor
product description 1
removal 75
spare part numbers 21, 35,
36, 75
product description
audio 3
chipset 1
diskette drive 3
display panel 2
docking support 5

Ethernet 4
external media cards 4
graphics 1
hard drives 3
keyboard 5
memory module 2
microphone 3
modem module 3
operating system 5
optical drives 3
pointing devices 5
ports 4
power requirements 5
processors 1
product name 1
security 5
serviceability 6
wireless 4
product name 1
R
rear component 15
recovery discs
creating 132, 138
using 136, 142
recovery partition 137, 143
recovery points 135, 141
removal/replacement
preliminaries 37
procedures 43
restoring Computer Setup factory
settings 95
right-side components 15
RJ-11 connector cable
removal 90
RJ-11 jack
location 15
pin assignments 147
RJ-11 jack cable
illustrated 27
RJ-45 connector cable
removal 90
RJ-45 jack
location 15
pin assignments 148
RJ-45 jack cable
illustrated 27

RTC battery
removal 57
spare part number 22, 34,
57
Rubber Kit, spare part
number 22, 35
S
scheduling backups 135, 141
Screw Kit
contents 112
spare part number 29, 35
screw listing 112
security cable slot 14
Security menu 97
security, product description 5
selecting in Computer Setup 95
serial number 17, 43
service considerations 37
serviceability, product
description 6
smart card reader 14
smart card security 97
speaker assembly
removal 85
spare part number 22, 35,
85
speakers 13
specifications
computer 100
display 101, 102, 103
DVD-ROM Drive 107
DVD-RW Drive 105
DVD/CD-RW Combo
Drive 106
DVD±RW and CD-RW Combo
Drive 105
hard drive 104
I/O addresses 110
interrupts 109
memory map 108
optical drive 105, 106, 107
system DMA 108
startup check 97
static-shielding materials 41
stringent security 97
switch cover
removal 67
spare part number 19, 34,
67
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system backup 134, 140
system board
removal 87
spare part numberS 87
spare part numbers 22, 34,
36
System Configuration menu 98
system DMA 108
system fan 98
system information 96
system memory map 108
system recovery points 135, 141
T
thermal material,
replacement 71, 73, 75
tools required 37
top components 8
top cover
removal 83
spare part numbers 21, 35,
36, 83
TouchPad
removal 64
spare part numbers 21, 35,
64
TouchPad buttons 12
TouchPad cable, illustrated 27
TouchPad scroll zone 12
transporting guidelines 40
U
Universal Serial Bus (USB) legacy
support 94, 98
Universal Serial Bus (USB) port
location 14
pin assignments 149
unknown password 42
USB/audio board
removal 91
spare part number 22, 34,
91
USB/audio board cable,
illustrated 27
V
vents 14, 15, 16
volume down light 11
volume mute button 8
volume mute light 11
volume scroll zone 9
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volume up light 11
W
Windows applications key 9
Windows logo key 9
Wireless Antenna Kit, spare part
number 19, 34
wireless antennae
disconnecting 56
locations 7
wireless button 8
wireless light 10, 13
wireless, product description 4
WLAN antenna, spare part
number 19, 34
WLAN module
removal 54
spare part numbers 22, 31,
32, 54
workstation guidelines 40

